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Turn Off Notifications

e Select the File menu and choose Options

¢ In the left area that lists the various categories, select Mail

e In the Message Arrival section, beneath When new items arrive in my Inbox, uncheck all the
checkboxes (no sounds, no notifications, no alerts!)

e Save

Effective Outlook Notification and Reminder Settings Video Tutorial >

Conversation View

View - Conversations - Show as Conversations
» You are controling Contractors screen (ORI

o @~ = P search =
File  Home  Send/Receive  Folder Y5 Help  Acrobat

C z S S Rev iy = —

S @ Z) +' Show as Conversations @ @ 1 Date (Conversations) €7 from (5 P I: @ ﬁ Q +lj T
s ~ | =1 Add Columns =7 2

ShowFocused | Message 85 Categories P Flag Status P Fiag: Start Date =10 ! Use Tighter Folder Reading To-Do | Reminders OpeninNew Close

Change View Reset
Inbox Preview v Expand/Collapse ¥ Spacing Panev Panev Barv Window  Window Al tems

Ve ol Vica ) Conversation Settings ~

Cutrent View Messages Focused Inbox Arrangement Layout Window ~
. x
v Favorites Focused  Other ByDatev | ACTION: NI contract DD 1/1/21 sacge by Py Due DatelTodey_=
Inbox v Today - % Sl
€ Reply | % Reply Al > Forward | | e
Taols Marcey Rader <marcey@helloraderco.com> s oy " v P Today
_> Contractor1; Marcey... © To Contractor] Fri 12/18/2020 9:38 AM Email to task M
Sent items. This is an email to create a .. 11:54 AM
Drafts g v PO Next Week
- - Tracy is promoted! fa
Deleted Items
Marcey Rader ALERT: AS9120 certification fi.. [0
ACTION: Ni contract DD 1/1... %39 AM

~ Marcey Rader =
v contractor1@tevet.com Marcey Rader

VInbax Marcey Rader Productivity Performance Speaker, Coach, Author
Professional Development This is an emall to create a . 9:38 AM 484-455-4122 EST
Prospects Marcey Rader Schedule a meeting here.
Ragiorts There are more items in this folder on the server WorkWellPlayMore.com is experiencing an exciting shift. My new email address is
D Connect to the server to view them marcey@helloraderco.com. More to come in 2021!
Sent items
A i

Conversation and From Views for Cleaner Inboxes Video Tutorial >
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Working Offline

e Working offline is a great way to focus on what's in your inbox without getting distracted by
incoming messages.
e When you wish to sync and send, select work offline, let your emails sync, send, and download,

then select work offline again to focus on the emails that are in your inbox.

) Yau wre coctroling Contrucior's soreen _
o ® = D Sesrch
e Home Send / Recelve Folder View
=
=y S0
,,,,, Downlosd  Work

Senc & Receme Downlood Servel Preferences

v Favorites Fe ¢ ther ByDatev |
Inbeox A i ey o [ today
Reports
Sent Nems Ak . bz m
Dradts v {0 Mext Ween
Bl S ft
S Marcey Rader ALERT: ASS120 centification I fo
ACTION: MW contrad DD 11, 3% AM
v contractor1 @tevet.com e ;hrcev Rader
nbox Marcey Rader Productivity Performance Speaker, Coach, Author
Professional Developr ™ 238 AM 484-455-4122 EST
Froics Schedule a meeting here,
WorkWellPlayMore.com is experiencing an exciting shift. My new email address is
P LA, A RE U A marcey@helloraderco.com. More to come in 2021!
Groups
You have not jomed any groups
o
= ' ' ot il om o i

Folder Structure

Consolidating folders

To consolidate folders, open a folder, click Control A to highlight all items, and then right click to
Move to the new folder.

Favorite folders

To keep your most-used folders at the top of your list, right click on them and Add to Favorites. When

you are no longer using that folder because the project isn't active, remove it from your favorites.

RADER CO. | www.helloraderco.com 4




Rules

Use Rules to auto-filter notifications or updates you dont need to see, but want access.
e Right click on an email.
o Click Create Rule
e Select From and type in the name or a subject for the message.

o Select the folder you want it to go to - Archives, Trash, Client Name, etc.

e Click Create Rule.

Don't click Ok yet! Select Run this rule now on messages already in Inbox.

Rules for Auto Filing Video Tutorial >

RADER CO. | www.helloraderco.com
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Automating emails from a specific sender into a folder

1. Open the email from the sender
2. Right click and select Rules - Move - Always Move Messages From (SENDER)
3. Highlight the desired target folder
4. Click Ok.
v Today
Marcey Rader <marcey@helloraderco.com>
b Contractor1; Marcey.. A5 @ To Contractorl
This is an email to create a ... 11:54 AM |
Test email = QOpen
Marcey Rader | [ Copy
AR M Qe !
> Forward Marcey !li_lder
Marcey Rader Productivity Performance Speaker, Coach, A
This is an email to cre.  [=) Mark as Read 484-455-4122 EST
-~ Marcey Rader 9 Mark as Upread Schedule a meeting here.
There are moreitemsin| B Categorize > WorkWellPlayMore.com is experiencing an e
Click here to view more. [ Follow Up , marcey@helloraderco.com. More to come in
% Quick Steps >
{5y Set Quick Actions...
_’ S Rules > Always Move Megfages From: Contractor]
Y Move > Always Mov: ssages To: Marcey Rader
£ Move to Other t’é Create Rule...
[FS Ignore %0 Manage Rules & Alerts...
[F2 Clean Up Conversation
@ Delete
RADER CO. | www.helloraderco.com




€ Repl % Re
@ Marcey Rader <marcey@helloraderco.com> T J e

To Contractorl

Create Rule Optional X

When | get email with all of the selected conditio
[ From Contractort

[z Subject contains | This is an email to create a rule

[[Jsentto | Marcey Rader

}AM 4
Sch Do the following

E] Display in the New ltem Alert window

server Wo . My new email
ma, E] Play a selected sound: Windows Notify Em | p ] Browse...
hange
[ Move the item to folder:  Reports I Select Folder... I
OK Cancel Advanced Options...

1. In the mail window, select a folder (or Inbox), click the View tab, and then click
View Settings in the Current Settings group.
2. Click Conditional Formatting in the resulting Advanced View Settings dialog box.

3. Click Add and give the new "rule" a name - such as The Boss.

4. Click the Font button, choose a color from the Color dropdown (pick one that is easy on the
eyes), and click OK.

5. Click Condition and then click From.

6. Find the contact, double-click it to add it to the From condition, and click OK four
times. (If creating a rule for messages sent, make sure you add the name to the

Sent To control.)

Outlook will display existing messages from the designated contact in the assigned

color. It will also show new incoming messages in that color as they arrive.

If the contact isn't in your Address Book, you can enter the contact's email address.

The name you're matching must exactly match the name Outlook displays in the From.

RADER CO. | www.helloraderco.com



You can't use the same rule to assign a color to messages from and sent, even though

the dialogs offer both options and will even let you specify both in the same rule.

Conditional formatting rules apply only to the current folder, but you can add the same

rule to multiple folders. Always start by selecting the right mail folder (#1).

Only add colors for 2-3 people or projects, or you will get too many colors and will ignore

P search
File Hom Send / Receive  Folder ~ View  Help  Acrobat
s = == i
Y {(é}; K) ! Show as Conversations @ 551 Date (Conversstions)!| CA From R 1o T1 Reverse Sort
~ | &= Add Columns
Change View Reset saltor - ShowFocused | Message 8§ Categories ] Flag Status P Fiag: start Date =
Vici s St Vi R Conversation Settings e s <9 lag g %| +— Expand/Collapse ~
Current View Messages Focused Inbox Arrangement
<
v Favorites Focused  Othe ByDatev | This is an email to create a rule in color
Inbox v Today
R Marcey Rader <marcey@helloraderco.com>
Reports
Contractor1; Marcey. To_ Contractorl
Sent items " il to create 11:54 AM -
cntitem e 2ot . Advanced View Settings: Compact
Drafts

Deleted ltems
ceted frem: Marcey Rader

them.

You are controlling Contractor's screen _

Desaription

Importance, Reminder, on, Atachment, From, Subjec

E0O0mE| QA O R

Use Tighter Folder Reading To-Do | Reminders OpeninNew Close

Spacing Panev Panev Barv | Window  Window Al ltems
Layout Window
te
Reply | % ReplyAll > Forward
v [ today
A Email to task

v [0 Next week

Tracy is promoted!

ALERT: AS9120 certification fi..

y new email address is

ACTION: NI contract DD 1/1 939 AM
v contractor] @tevet.com ‘ fade Group By... Conversation (ascending)
v Inbox Marcey Rader Sort... Received (descending)
Professional Development This is an email to create a ... 238 AM
Prospects Marcey Radee Filter... oft
Reports There are more items in this folder on the Other Settings... Fonts and other Table View settings
L Connect to the server to view them
Sl —’ Conditional Formatting... | User defined fonts on each message
Deleted ltems Format Columns... Specify the display formats for each field
Archive
Conversation History Reset Current View oK Cancel
Junk Email @
P
_at N SN ==
A € Conditional Formatting X
Description Ryles for this view:
ca [ Unread group headers A Subjed, ..
4 [ submitted but not sent
{ e [ Expired email Delete
| [ overdue emait
| [V Messages in other folders
[ site Mailbox document pending uploa Move Up
! [\ The Boss
{ [ marcey Rader v Maove Down
Properties of selected rule
! Of Name Marcey Rader *— y new
Conditio Font... 11 pt. Segoe Ul
Fonu Condition...
Reset OK Cancel [ Cancel
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= —
Font X
Ad <
O Font: Font style: Size:
I- Segoe Ul Regular Normal | ok |
. 5 Smaller ——
Segoe Ul = “ } 2 Cancel
U Segoe Ul Emoji |ltalic Big
Segoe Ul Historic 'Semibold Bigger
n 1 - »
I Semibold Italic
4 |Bold v
: Effects Sample
U [ strikeout y new
AaBbYyZz
4 underline ¥
L Color:
D Red v Script:
[Westem v
I 1
— =
<
Focused Other ByDatev | Tk
v Today
» Contractor1; Marcey... LD q
This is an email to create a ... 11:54 AM
Test email
Marcey Rader
ACTION: NI contract DD 1/1... 9:39 AM
- Marcey Rader —
Mai
Marcey Rader Pra
This is an email to create a .., 2:38 AM 48¢
- Marcey Rader Sct
There are more items in this folder on the server Wo
Connect to the server to view them ma

Creating a Rule for Color Video Tutorial >

Ignoring Conversations

When you get stuck on an email chain of congratulations, announcements, or anything else
you don't want, choose to ignore the thread by selecting the email and clicking Ignore. Future

emails from that thread will go to your deleted folder rather than clutter up your inbox.

RADER CO. | www.helloraderco.com
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If you change your mind, you can go to the email in your Deleted Items folder, select it and

click the Ignore button again to disable it.

FILE Home Send / Receive

t?[‘\';lgnore
Clean Up ~
New New o Delete
Email ltems~ & Junk~
New Delete

Ignoring Conversation Video Tutorial >
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Tasking

Quick Step for Tasking

Don't use your inbox as your task list! You can't prioritize, and you have to look at what you
need to do repeatedly. For team projects, | recommend using a project management task
system like Planner, Asana, or ClickUp, and not delegating through email You can use Planner,
ToDoist, or the native Outlook for personal tasks if you have simple tasking to perform. I do
not recommend creating flags. Again, you can't prioritize by date, it stays in the Inbox, and

most people end up having hundreds of red flags they never clear out.

RADER CO. | www.helloraderco.com

I



ed Other

actor1; Marcey...
an email to create a ...
il

2y Rader
{: NI contract DD 1/1..
‘cey Rader

2y Rader

an email to create a ..,
cey Rader

more items in this fol

: to view more on Mic

nonoa 1 -~

@
w5
=
%
P

B P es d 7 LD

84

B » g

Copy

Quick Print
Reply

Reply All
Forward

Mark as Read
Mark as Upread
Categorize
Follow Up

Find Related

Quick Steps

Set Quick Actions...
Rules

Move

OneNote

Move to Other

Always Move to Other
Ignore

Junk

Delete

Archive...

Convert to Adobe PDF

Append to Adobe PDF

zey Rader
luctivity Performance Speaker, Coach, Author
455-4122 EST
:dule a meeting here.

Task
El] Reports
—> To Manager

B Team Email
v/ Done
€5 Reply & Delete

“;5 Create New

New Quick Step

% Manage Quick Steps...

Marcey Rader <marcey@helloraderco.com>
Te Contractorl

‘s is an email to create a rule in color

) Reply

kWellPlayMore.com is experiencing an exciting shift. M|

(S RNy | PR )

1. More to come in 2021!

Move to Folder...
Categorize & Move..,
Flag & Move...

New E-mail To...
Forward To...

New Meeting...

Custom...
All folder

RADER CO.
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2 - =1 == unread/ . =
? Forward Eb 2% Manager b OneNote F Py v Filter Email v

Read l
A
Respond 5 = Find
2 Edit Quick Step ? X
ByDatev |
| ey Name:
‘» pus % Reply Al
<_) Add actions below that will be performed when this quick step is clicked on.
11:54 AM
Actions
Create a task with attachment | v [E
9:39 AM
Y Move to folder v | W
‘ Always ask for folder v
9:38 AM
 Add Action
ier on the server r new email a
rosoft Exchange
Optional
L ET OOl CTRL-SHIFT- 1 |Re
Tooltip text: “Tms text will show up when the mouse hovers over the quick step. ‘
[

You can take extra action to delete the message. If you like to put everything in files, select Always
ask for folder, to it is saved in your task list and your selected folder.

Tasking from Email Video Tutorial >

How to add tasks to an Outlook calendar

1. On your calendar screen, click View

2. Click Daily Task List

3. Click Normal.

4. Drag and drop a task into a calendar item for a specific time.
RADER CO. | www.helloraderco.com




Meeting Request

Turn off meeting request responses.

In a new meeting request, do the following:

1 On the Meeting tab, in the Attendees group, click Responses.

NOTE: For recurring meetings, the Meeting tab appears as the Recurring Meeting tab.

2. Click Request Responses to clear the Request Responses and Allow New Time

Proposal checkboxes.

; | @I Responses ! es
&1‘ V. | Request Responses £

i VIS &llow News Time Proposals r

|
|

NOTE: If you turn off the Request Responses option, you will not be able to track whether
attendees have accepted, tentatively accepted, or declined. For instance, when you open the
meeting in your calendar, click the Meeting tab, and then click Tracking in the Show group, the
Response column will display None for all of the attendees. Instead, you could create a rule that

meeting responses go directly to your archives, trash, or another folder.

Turn off responses after you send the meeting request.

Even if you don't turn off the response option when you initially send the meeting request, you

can change the option at any time.

. Open the meeting.
2. On the Meeting tab, in the Attendees group, click Responses.

NOTE: For recurring meetings, the Meeting tab appears as the Recurring Meeting tab.
3. Click Request Responses to clear the Request Responses and Allow New

Time Proposal checkboxes.

4. Click Send Update, so the meeting request updates in Outlook for all meeting attendees.

RADER CO. | www.helloraderco.com

14



Search folder

There is no reason to scroll up and down your inbox to find an email anymore. If you are doing
this, you got into the habit with older versions of Outlook. You can streamline your searching by
going to the Search Folders on the left and creating a new Search Folder. Examples could be

all your Unread or Follow Up or Unread from NAME.

How to Search All Folders in Outlook

This step is only necessary for older versions of Outlook. Create an Outlook Search Folder that will

search through all of your mail in one step. It will not search inside any archived .PST files.

Create an All Mail Search Folder in Outlook

= = [Draft] Peter
pSearch Folders
New Search Folder... L.

In the folder Navigation list, right click the header that says Search Folders and then select New
Search Folder.

RADER CO. | www.helloraderco.com
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New Search Folder

Select a Search Folder:

Mail from and to specific people
Mail from specific people

Mail sent directly to me

Mail sent to public groups

Organizing Mail

Categorized mail

Large mail

Otd mail

Mail with attachments
Mail with specific words

‘Custom

Create a custom Search Folder

Customize Search Folder:

To specify critena, click Choose,

OK

Cance!

www.helloraderco.com
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Scroll to the bottom of the window and double click where it says Create a custom search folder.

Custom Search Folder X

9 Name: All Mail Search Folder

Select "Criteria" to specify what items this Search

Criteria...
Folder contains.

Mail from these folders will be included in this Search Folder:

.Lookeen Blog;Drafts;Junk-E-Mail;Lookeen 10;siobhat || Browse..

OK Cancel

Another window called the Custom Search Folder will open up. Type All Mail Search Folder in the

Name field box, then click Browse.

> =1 Other
Peter v
[\/] Search subfolders '

Searching in 8 folder(s):
.Lookeen Bloq; .Responses; .To Do; Website; Lookeen 10; Lookeen Free

RADER CO. | www.helloraderco.com



Now select which folders you want to include in your All Mail Search folder. Uncheck the first item,
and then check all of the folders you store your most important mail in. This will probably be your
Inbox, the Sent Items folder, and any others you need to include in a global search. Check the box

that says Search Subfolders at the bottom. Now click OK.

Microsoft Cutlook X

You have not specified any criteria for this Search Folder. All messages in the felders you have selected will appear in this Search Folder,

Do you want to continue?

Click OK. A box will show up saying that you have not specified any criteria. Click Yes at this

error because you don't want to create any requirements for this.

4 | pSearch Folders

HAll Mail Search Folder 450

pUnread Mail

Now click OK again, and you should now see the All Mail Search folder in the Search Folder

List. It may take some time to load the first time. After it has loaded, arrange the folder by

Date.

Search All Folders by Default in Outlook 2010 and 2013

RADER CO. | www.helloraderco.com



Set up Outlook to search the items within All Folders by default.

Click File and then select Options.

In the Outlook Options window, click Search, choose the All mailboxes option.

Tasks

Results
Search = Include results only from:
Language . O Current folder
Advaniced O Current folder. Current mailbox when searching from the inbox

O Current mailbox
Customize Ribbon
@® All mailboxes
Quick Access Toolbar
[ include messages from the Deleted items folder in each data file when searching in All Items

Add Ins

[ When possible, display results as the query is typed

Click OK. You will now search all folders by default in Outlook 2010 and 2013.

All/Unread vs. Focused/Other

With Focused and Other, you will only get emails from within your organization in the focused
mailbox and newsletters and emails outside the organization in your Other mailbox. This

method works well if you mostly communicate internally.

Message Templates

Creating an email message template

0

New group - New E-mail.

2. In the message body, enter the content that you want.
3. File tab.

4. Click Save As.

5. In the Save as box, click Outlook Template in the Save as type list (do not save it to My

Documents or some other folder). Type a name for your template, and then click Save.

Sending an email message from a template

RADER CO. | www.helloraderco.com
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l.  Select New ltems (upper left corner) > More ltems > Choose Form.

2. Look In, click User Templates in File System.

3. The default templates folder is opened
c:\users\username\appdata\roaming\microsoft\templates. If your template is saved in a
different folder, click Browse, and find it.

4. Select the template, and click Open.

5. You can make changes to the subject and message body.

Note - Changes made aren’t saved to the template. It will create a draft of your current message

if you save but won't update the template.

Recall or replace an email message.

With message recall, a message you sent is retrieved from the recipients who haven't yet opened it
from the mailboxes. You can also substitute a replacement message. For example, suppose you
forgot to include an attachment. In that case, you can attempt to retract the message and then send

a replacement message with the attachment.

Message recall is available after you click Send and is available only if both you and the recipient

have a Microsoft 365 or Microsoft Exchange email account in the same organization.

Newer versions

1. In the folder pane on the left of the Outlook window, choose the Sent Items folder.

2. Open the message that you want to recall. You must double-click to open the message.
Selecting the message, so it appears in the reading pane, won't allow you to recall the
message.

3. From the Message tab, select Actions > Recall This Message.

RADER CO. | www.helloraderco.com 20



RIE: This is s emasil to create & rule - Message (HTML)

ey  File Message Heip Acrobat Q Tell me what you want to dao
ew = -
| 9] Tast : - | FIMarkUniead | i, 0 =l
e By ™Ere 2= DM =ees s QD 0| H
oitey oo Delete Archive | Reply Reply Forward - > r“rm g = | Move BaGategorze | L L BT | e | Zoom Isights | Clowd Extend | Phish Alert
w All 2 e aciger ~ [B= | M Followup- - | Alpud HetSuite Hepart
«
Delete Respand Dk Steps & M Edit Message Editing Speech | Toom Celiga Prizh Alert ~

s y
Ttend — | 7 Recall This Message. ™

RE: This is an email to create a rule

[7] Regond This Message... -
€ Reply @y Rephy All 3 Fonanrd

e ° Contractor] Yhew in Browwsar
To Contractor] = £ 12/10/2020 1:05 PM
iy Other Actions >
tracf
e This will recall a message from your sent folder if the recipient hasn't opened it.

fe5id From: contractort
wpect| Senk: Friday, Decemnber 18, 2020 11:54 AM

yorte | Tt Marcey Rader <marcey@helloraderco.com>
Subject: RE: This is 2n email to create a rule

ltemsl Test email

e From: Marcey Rader <marcey@helloraderoo.coms>

Sent: Friday, Decernber 18, 2020 %:37 AM

To: Contractor] <contractor 1@t evel.come
Subject: This is an email to create a rule

Recall This Message X

Some recipients may have already read this message.

Message recall can delete or replace copies of this message in recipient
Inboxes, if they have not yet read this message.

Are you sure you want to

(®) Delete unread copies of this message
O Delete unread copies and replace with a new message

E] Tell me if recall succeeds or fails for each recipient

| oK | | Cancel

Notes:

e If you don't see the Recall This Message command, you probably don’t have
an Exchange account, or the feature isn't available within your organization.
e You cannot recall a message that's protected by Azure Information Protection.

e You cannot recall a message in Outlook on the web.

4. Click Delete unread copies of this message or Delete unread copies and replace with a new

message, and then click OK.

5. If you're sending a replacement message, compose the message, and then click Send.

To Enable or Disable Notifications of Completed Print Jobs
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1. Click Start, and then click Printers and Faxes.
2. On the File menu, click Server Properties.
3. On the Advanced, click the options you want to apply:
a. Show informational notifications for local printers. This option notifies users when a job
is printed on a printer that is attached to this computer.
b. Show informational notifications for network printers. This option informs users of this
computer when a job is printed on a remote computer.
4. For client computers that are running versions of Windows earlier than Microsoft
Windows 2000 that access the printers on this computer, there are additional
configuration options to choose from:
a. Notify when remote documents are printed. This option sends a message to
the user who sent a job to a printer attached to this computer.
b. Notify computer, not user, when remote documents are printed. This option
sends a message to the computer from which the print job was sent,

regardless of which computer the sending user is currently logged on.

Publishing a Calendar for External Viewing

Suppose you don't have a scheduling system like Acuity, Book Like a Boss, or Calendly, and often have
meetings with external clients or vendors. In that case, you can publish your calendar for external
viewing. To make it easy for people to schedule with you, provide a hyperlink to your calendar in your

signature line, or provide it when scheduling meetings.

File Home Send / Receive Help t obat ell i o do

[ R a Q @ & :] [: E :] Sl B R ot
LAY o - 3 ad
New (PRI 2 o e Start Instant pe | Newtoams | ‘To Doy | Wk 3]” it Manage \ Share s
Appointment Meating wv‘_, - Masting Mastir Vs Wvok BBl schedule View  Calendars v

Skype Meeting | Teams Mot Go T & Arrange ] Groups o ~

Todsy oo ow Wednesday
¢ Decombera020  » « » December7-11, 2020 Exetor, Now Hampshirs * ¢ S iciisd e
0 1 2 3 a MONDAY TUESDAY WEDNESDAY THURSOAY FRIDAY
- £ 91001 2 7 a A 10

13 14 15 16 17 A 19

20 020 22 23 24 25 26
27 28 29 30 N

RADER CO. | www.helloraderco.com 22



File Home Serxd / Recewve Folder View Help Mimecast Acrobat Q  Tell me what you want to do

-t — . — — " x

] l:, Q (:) W EE 5 S week 7 & | HiomeGroups | Seach People

N ; J @ Address Book
ow

.0
New EINeWlemsY | o e i ingtunt | New Siype | NewTeams | Todey Next7 | Doy, [ O Month Manage | Sham
Appaintment Meeting Meeting ¥ Meeting ¥ Mseting Mestng Days Week Esu‘um View Calendars ~ -
New Zoom Skype Meeting | Teams Meeting Go T = Arange 1
<
. Tomorrow
¢ Dscombero20 v « » December7-11,2020  exeter, New Hampshire = <2 D0V kg
SU MO TU WE TH FR SA
230 123 A5 TUESDAY WEDNESDAY THURSI
6 ”?
EB:>v0n £ & 3 i

13 14 15 16 17 @ 9
MM 223 MBS B
T 2w 0N

File Home Send / Receive Folder View Help Mimecast Acrobat O Tell me what you want to do

g_ﬁ D0 ©® %

=) ') A8 Browse Groups

8 9 1 1 w2
Y § 8 9 10
13 14 15 16 17 18 19
2D 2% 22 23 24 5 2%
27 28 29 %0 3N

RADER CO. | www.helloraderco.com

=
New TONewltems | oo attinstnt | New Skype | NewTaams | Today Next? Manage  Sharw
Appointment Meeting Meeting ¥ Mesting ¥ Meeting Meeting Days Calondars ¥ v
New Zoom Skype Meoting | Toama Meeting Go To 1] Arrange (] Groups
<
o My " o R —_—a ey
‘ December 7 - 11, 2020 Exeter, New Hampshire = €25 [C0 i & »
SU MO TU WE TH L SA E-mad  Share Publsh (nlef\m\r
Calendar Calens
0428 4 m TUESDAY WEONESDAY THURS(
Publish This Calendar...

Publish this calendar for access by users on

ch People

Address Book

Find ~

04 g

23



@R Mail - Katie Horrick - Outlook x 4 = a X

. C & outlookofficecom/mall/inbox

@ Qq~sHD O:
B Apps A N Case Management % Bookmarks J* QiMedicare.com Y & Sugarioaf Mountain D New Tab

WorkDay \8f Participant Login

=) Suggested Sites » Other bookmarks

: ? |~
o
RareMed/Yi

= 2 Mark all as read 8 ,::: z_,_.‘,,: 5

om - Settings X
Vv Favorites l D Search Outlook settings I
(o) Inbox 1 Theme
B Sent Items
B Deleted.. 4564

Add favorite

Vv  Folders

View all
Dark mode ()
(&} Inbox 1 Select an item to read @
Nothing is selected 0
& Drafts 4 9 Focused Inbox (@ @)
- Sent Items

Desktop notifications @
Deleted | 4564 —

= g £

RADER CO.

www.helloraderco.com 24



R Mail - Katie Hemick - Outlook X <= = a X

& c @& outlook.office.com/mail/options/calendar/SharedCalendars @ % Q“ ~ S . » .
2 Apps A WorkDay \M Participantlogin ){ Case Management.. W Bookmarks % QlMedicarecomY.. @ Sugarloaf Mountain. @ NewTab [8) Suggested Sites » Other bookmarks

Settings Nicer Shared calendars X
0 search settings Events and invitations i
Publish a calendar
Weather
€3 General You can publish a calendar and share a link with other people 1o let them view the calendar online, Use an HTML link

SCnoe.

Events from email if you want recipients to view the calendar in a browser or an ICS link if you want them to sub
= Mail /_—_—‘\
Shared calendars 1\( ‘/I,)
ect a calendar 4
@ Calendar —

ri ;i
Customize actions -
£ People deﬂ view when I'm busy

Accounts
View quick settings e Calendar

Can view when I'm bu

’ Unpublish

HTML: t

@blueprintmedicines.com/09¢ ’ Reset links

82600237/ calendar html

outlook.office3 lendar/11118e96e15d43dcb9e1fb3e18ac366
ueprintmedicines.com/09 224c0d9d06bhIe35eeb9d3131526751417

70260237/ calendar.ics

Speed Reading

To read your email faster in Reading Pane view, you can use the space bar to move down the
message and then go to the next message. Go into Options - Mail - Outlook Pane - check
Single key reading using space bar. Only do this if your current way of reading isn't working for

you.
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This Outlook Go-To Guide is designed to help you set up your email for maximum efficiency and only
the beginning of what Outlook can provide. However, the best systems and tools mean nothing when

the behaviors aren't effective. Start with the system and follow with the actions.

Need help with that?

We're here for you for private and team coaching.

Contact us at helloehelloraderco.com.
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